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Safety instructions

General safety instructions

� Assembly, start-up and operation of this device may only be performed by
trained and experienced personnel familiar with the product.
According to these mounting and operating instructions, trained personnel
refers to individuals who are able to judge the work they are assigned to
and recognize possible hazards due to their specialized training, their
knowledge and experience as well as their knowledge of the applicable
standards.

� Any hazards which could be caused in the connected valve by the process
medium, operating pressure or moving parts are to be prevented by means
of the appropriate measures.

� Proper transportation and storage are assumed.

� The actuators has been designed for use in electrical power installations.
For wiring and maintenance, you are required to observe the relevant safety
regulations. The actuator must be protected against unintentional
reconnection of the power supply.

� Note:
Actuators with a CE marking fulfill the requirements of the Directives
94/9/EC and 89/336/EEC.
The Declaration of Conformity is available on request.



1 Design and principle of
operation

The Type 5757-7 consists of a digital con-
troller integrated into the housing of an elec-
tric actuator.

The combination is especially designed for
heating applications as well as for fixed set
point control of heating systems in small to
medium-sized buildings. It is particularly
suitable for mounting to SAMSON
Type 3222, Type 3222 N, Type 2488 and
Type 3267 Valves (DN 15 to 25) and to
special versions of Type 3226 and
Type 3260 Valves.
The digital controller is connected to a flow
sensor on the input side, which can be op-
tionally upgraded by a return flow, outdoor
or room sensor.
In addition to the Pt 1000 input, the digital
controller has a potentiometer input (1000
to 1100 Ωor 1000 to 2000 Ω) to measure
the flow temperature. This input influences
the heating characteristic in the case of out-
door temperature compensated control and
the room temperature set point in the case of
fixed set point control with room tempera-
ture influence.
Heating characteristic and set point parame-
ters can be changed over the TROVIS-VIEW
Operator Interface.

The output signal of the integrated digital
controller is applied as a three-point step-
ping signal to the synchronous motor of the
actuator. The signal is transferred over the
connected gear to the actuator stem (3) and
used as the positioning force.
The motor is switched off by torque-depend-
ent switches when an end position is
reached or in case the motor is overloaded.

The actuator is mounted onto the valve using
a coupling nut (4).
When the actuator stem extends, the valve is
closed, opposing the force of the valve
spring (7). When the actuator stem retracts,
the valve is opened as the plug stem (6) fol-
lows the motion of the return spring.
The valve can be moved to any position
when the power supply is disconnected by
the handwheel (2). Travel and direction of
action can be read off the travel indicator
(5) on the side of the actuator housing.
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Fig. 2 · Functional diagram

Stem retracts

Stem extends

1 Controller/actuator
1.1 Connecting lead
2 Handwheel (only to

be used when power
is disconnected)

3 Actuator stem

4 Coupling nut
5 Travel indicator
6 Plug stem
7 Valve spring
8 Cover, serial

interface connection
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1.1 Accessories

Heating applications, see section 5

� Type 5267-2 Pt 1000 Contact Sensor
Permissible temperatures:
Medium –20 to 120 °C
Ambient –20 to 120 °C
Degree of protection IP 42

� Type 5257-2 Pt 1000 Room Sensor
with potentiometer (remote adjuster)
Permissible temperatures:
Medium –35 to 70 °C
Ambient –35 to 70 °C
Degree of protection IP 20

� Type 5257-7 Room Panel with
potentiometer and mode selector switch
Permissible temperatures:
Medium –20 to 60 °C
Ambient –20 to 60 °C
Degree of protection IP 30

� Type 5227-2 Pt 1000 Outdoor Sensor
Permissible temperatures:
Medium –35 to 85 °C
Ambient –35 to 85 °C
Degree of protection IP 44

Communication, refer to section 6

� TROVIS-VIEW Configuration and Opera-
tor Interface (6661-1066) for
Type 5757-7 Controller with Electric Actu-
ator

� Hardware package
Accessories for direct and indirect data
transmission (including a memory pen,
connecting cable and modular adapter),
order no. 1400-7704

� Memory pen
Indirect data transmission,
order no. 1400-7697

1.2 Technical data

Type 5757-7 Controller with Electric Actuator

Temperature sensor Max. 3 x Pt 1000

Setting range 0 to 150 °C

Potentiometer input 1000 to 1100 Ω or
1000 to 2000 Ω

Binary output 230 V/50 Hz/1 A
Circulation pump or
external heat demand

Rated travel 6 mm

Transit time for
rated travel 20 s

Nominal thrust 300 N

Supply voltage 230 V (±10 %) / 50 Hz

Power consumption Approx. 3 VA

Permissible  temperatures

Ambient 0 to 50 °C

Storage –20 to 70 °C

Degree of protection IP 42

Mounting position Any, but not suspended

Noise immunity EN 61000-6-2

Noise emission EN 61000-6-3

Weight Approx. 0.7 kg
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2 Connection to the valve

The actuator has a force-locking connection
to the valve in de-energized state.

� Turn the handwheel (2) counterclockwise
to retract the actuator stem as far as it
will go.

� Place the actuator on the valve connec-
tion and screw coupling nut (4) tight
(tightening torque 20 Nm).

2.1 Mounting position

Any mounting position may be used, how-
ever, may not be installed in a suspended
position.
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2 Handwheel
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4 Coupling nut

Fig. 3 · Connecting actuator and valve



3 Electrical connection

When installing electric lines, you
are required to observe the regula-
tions governing electrical power
plant installation according to
DIN VDE 0100 as well as the regu-
lations of your local power supply
company.
Use a suitable power supply which
guarantees that no dangerous volt-
ages reach the device in standard
operation or in case of a fault in the
system or any other system parts.

The controller with electric actuator requires
a Pt 1000 temperature sensor (e.g. Type
5267-2) to be connected to measure the
flow temperature.
Depending on the control task, an outdoor
sensor (e.g. Type 5227-2) or a room sensor
(e.g. Type 5257-2) or a room panel
(Type 5257-7 only) can be connected. Com-
bining one of these sensors with a return
flow sensor (e.g. Type 5267-2) is usually
possible.

Additionally, the controller with electric ac-
tuator has a potentiometer input 1000 to
1100 Ω (e.g. Type 5257-7) or 1000 to
2000 Ω (e.g. Type 5257-2). This input is
used to correct the room set point (± 5 K) in
case of fixed set point control with room
temperature influence (see section 5.2). On
using an outdoor  sensor, it can change the
adjusted heating characteristic (see sec-
tion 5.1).
The non-floating pump output can alterna-
tively be used as an binary output for an ex-
ternal request for heat demand.

The connected sensors are monitored for
line breakages.
A fault in the line of a sensor is indicated by
the red LED blinking slowly.

Caution!
Connect the actuator to the electrical
network only after the power supply
has first been switched off. Make
sure the power cannot be switched
on unintentionally!

The pump output L’ is non-floating
(230 V~).

� Perform the electrical connection de-
pending on the heating application ac-
cording to one of the following wiring di-
agrams (Figs. 4 and 5).
As soon as the actuator is connected to
the power supply, the initialization pro-
cedure starts.
The actuator stem extends (with operat-
ing direction selected for globe valves)
and the red and yellow LEDs are illumi-
nated located under the cover on top of
the actuator.
As soon as the actuator stem has
reached the final position, the red LED is
turned off. The yellow LED remains illu-
minated and indicates that the controller
with electric actuator is ready for opera-
tion.
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Fig. 4 · Wiring diagrams Note: Terminals at point of installation, not included in scope of delivery
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Electrical connection

Fig. 5 · Wiring diagrams Note: Terminals at point of installation, not included in scope of delivery
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4 Dimensions in mm
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Fig. 6 · Type 5757-7 Controller with Electric Actuator
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Type 5267-2 Contact
Sensor, Pt 1000
(flow and return flow
temperature measurement)

Type 5227-2 Outdoor Sensor,
Pt 1000
Color: RAL 9016

Type 5257-7 Room Panel, Pt 1000
Color: Cover and knobs RAL 9016 · Base RAL 7047

Type 5257-2 Room Sensor, Pt 1000
(remote adjustment)
Color: RAL 9010

Continuous day mode (rated operation)
Continuous night mode (reduced operation)
Off/frost protection

Fig. 7 · Accessories for heating applications



5 Functions

Functions and parameters are entered in the TROVIS-VIEW Operator Interface (see
section 6).

5.1 Outdoor temperature compensated control

In the outdoor temperature compensated control, the flow temperature (tVL) is automatically
adjusted in relationship to the outdoor temperature (tA). The heating characteristic in the con-
troller defines the set point for flow temperature as a function of the outdoor temperature
(Fig. 8).
Basically, the following correlation exists: If the outdoor temperature drops, the flow temper-
ature rises. By varying the Gradient and Level parameters, the characteristic can be adapted
to individual requirements: An increased Gradient causes an increase in flow temperature,
whereas a reduced Gradient causes a lower flow temperature. The Level parameter shifts the
heating characteristic parallely upwards or downwards.
In reduced operation, the flow temperature is reduced by the amount set in Flow temperature
setback in reduced operation. The Maximum flow temperature and Minimum flow tempera-
ture parameters limit the flow temperature range. Return flow temperature limitation (see
section 5.5) is an exception as it can reduce the flow temperature without restriction down to
20 °C flow temperature set point.
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Functions WE Configuration

F01 – Control mode 1 F01 - 1

F02 – Selecting the reference variable 0 F02 - 0

Parameters WE Range of values

P02 – Flow temperature set-back in reduced
operation

15 K 0 to 50 K

P03 – Min. flow temperature 20 °C 0 to 150 °C

P04 – Max. flow temperature 120 °C 0 to 150 °C

P05 – Heating characteristic gradient 1.6 0.2 to 3.2

P06 – Heating characteristic level 0 K –30 to 30 K

Examples for setting the heating characteristic:
� Old building, radiator design 90/70: Gradient approx. 1.8
� New building, radiator design 70/55: Gradient approx. 1.4
� New building, radiator design 55/45: Gradient approx. 1.0
� Underfloor heating depending on arrangement: Gradient smaller than 0.5
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Fig. 9 · Typical application: Outdoor temperature compensated flow temperature control with return flow limitation;
switching between operating modes using a binary contact



5.1.1 Override using potentiometer

The potentiometer input (e.g. by connecting Type 5257-2 with remote adjustment) can
change either the heating characteristc level or gradient, depending on the configuration.
The parameters Gradient shift range via potentiometer and Level shift range via potentiome-
ter are used to adjust the range (±) in which the influence is to take place.

Functions WE Configuration

F05 – Potentiometer input 0 F05 - 1

F06 – Resistance range of potentiometer 0 F06 - 1 (Type 5257-2)

F07 – Potentiometer function 0 F07 - 0: Level shift
F07 - 1: Gradient shift

Parameters WE Range of values

P07 – Gradient shift range via potentiometer 1.0 0.0 to 1.5   (only with F 07 - 1)

P08 – Level shift range via potentiometer 15 K 0 to 30 K (only with F 07 - 0)

Examples:

� Potentiometer function F07 - 0
Heating characteristic gradient P05 = 1.6
Gradient shift range via potentiometer P07 = 1.0
⇒ The gradient can be shifted between 0.6 and 2.6 (± 1.0).

� Potentiometer function F07 - 1
Heating characteristic level P06 = 0 K
Level shift range via potentiometer P08 = 15 K
⇒ The level can be adjusted between –15 K and +15 K (± 15 K). The limits adjusted

for the flow temperature still apply.

5.1.2 Summer mode

Should the outdoor temperature exceed the Outdoor temperature limit value (rated opera-
tion/reduced operation), the controller switches off the heating, i.e. the valve is closed and
the circulation pump is switched after the Pump lag time has elapsed.
The heating is switched on again when the outdoor temperature falls below the set point.

Parameters WE Range of values

P17 – Outdoor temperature limit value at rated operation 22 °C 0 to 50 °C

P18 – Outdoor temp. limit value at reduced operation 15 °C 0 to 50 °C

P22 – Pump lag time 5 min 1 to 999 min
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5.1.3 Delayed outdoor temperature adaptation

The calculated outdoor temperature is used to determine the flow temperature set point. The
heat response is delayed when the outdoor temperature either decreases, increases or in-
creases and decreases.
If the outdoor temperature varies by, for example, 12 °C within a very short period of time,
the calculated outdoor temperature is adapted to the actual outdoor temperature in small
steps. Assuming a Delay of 3 °C/h, the linear adaptation would take = 12

3

°

°

C

C /h
= 4 h.

Note!
The delayed outdoor temperature adaptation helps avoid unnecessary overloads of central
heating stations caused by either overheated buildings occurring, for example, due to warm
winds, or temporarily insufficient heating due to the outdoor sensor being exposed to direct
sunshine.

Functions WE Configuration

F04 – Delayed outdoor temperature 0 F04 - 1

Parameter WE Range of values

P16 – Delayed value for outdoor temp. adaptation 3 °C/h 1 to 6 °C/h

5.2 Fixed set point control

The flow temperature is controlled to the fixed value in Flow temperature set point. In re-
duced operation, the flow set point is used for the control reduced by the amount in Flow
temperature set-back in reduced operation. A connected outdoor sensor does not have any
effect on the control.

Functions WE Configuration

F01 – Control mode 1 F01 - 0

Parameters WE Range of values

P01 – Flow temperature set point 70 °C 0 to 150 °C

P02 – Flow temp. set-back in reduced operation 15 K 0 to 50 K

5.2.1 Room temperature influence

On connecting a Type 5257-7 Room Panel, the Flow temperature set point is influenced by
the room temperature:
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The heat supply is matched to the required amount over a permanently active flash adapta-
tion. The room sensor is polled at regular intervals (Tr Flash adaptation). If the room temper-
ature is lower than the Room temperature limit at rated operation or Room temperature limit
at reduced operation, the flow temperature is raised based on the Flow temperature set
point.

If the room temperature exceeds the room temperature set point (rated operation/reduced
operation) by the amount in Maximum room temperature boost, the heating is switched off,
i.e. the valve is closed and the circulation pump is switched off after the Pump lag time has
elapsed.

In the event, the parameter P12 – Tr Flash adaptation is set to 0, the control is a pure fixed set
point control without room temperature influence.

Note!
We recommend not to select a value that is too low for parameter P12. In particular, in cases
where cooling loads, such as drafts or open windows, affect the control process, short cycles
usually have a negative effect. The heating is directly switched off after the cooling stops.
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Fig. 10 · Typical application: Fixed set point control with room temperature influence and return flow temperature
limitation; switching between operating modes at room panel (Type 5257-7)

AS Outdoor sensor
RüS Return flow sensor
VS Flow sensor

UP Circulation pump
RL District heating network return flow
VL District heating network supply



Note!
The set points for room temperature entered in TROVIS-VIEW can be reduced or raised by
5 K at the room panel.

Functions WE Configuration

F01 – Control mode 1 F01 - 1

F02 – Selecting the reference variable 0 F02 - 1

Parameters WE Range of values

P01 – Flow temperature set point 70 °C 0 to 150 °C

P12 – Tr Flash adaptation 10 min 0 to 100 min

P19 – Room temperature limit at rated operation 20 °C 10 to 40 °C

P20 – Room temperature limit at reduced operation 15 °C 10 to 40 °C

P21 – Maximum room temperature boost 1 K 1 to 6 K

P22 – Pump lag time 5 min 1 to 999 min

5.3 Operating modes

5.3.1 Switchover via binary input

The active binary input determines which operating mode is used. Depending on the config-
uration, the following applies:
� F08 - 0 Open binary input – Rated operation

Closed binary input – OFF/Frost protection
� F08 - 1 Open binary input – Rated operation

Closed binary input – Reduced operation

Note!
It is not possible to connect the Type 5257-7 Room Panel at the same time in this case (see
section 5.3.3 on Switchover via binary input in room panel).

Functions WE Configuration

F05 – Potentiometer input 0 F05 - 0

F08 – Binary input function 0 F08 - 0: Rated operation + OFF/Frost protect.
F08 - 1: Rated and reduced operation
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5.3.2 Switchover via room panel

The operating mode of the controller is determined at the mode selector switch on the
Type 5257-7 Room Panel:

Rated operation (day mode)
Reduced operation (night mode)
OFF/Frost protection

Functions WE Configuration

F05 – Potentiometer input 0 F05 - 1

F06 – Resistance range of potentiometer 0 F06 - 0 (Type 5257-7 Room Panel)

5.3.3 Switchover via binary input in room panel

The terminals 1 and 4 of the Type 5257-7 Room Panel can be bridged by means of an ex-
ternal floating contact (e.g. by a time switch with downstream contactor relay with floating
make or break contact). This enables the controller to switch to the rated operation mode
when the mode selector switch is set to reduced operation or OFF/Frost protection .
The following applies:

� BI break contact Operating mode is the same as the mode set at the mode selector
switch

� BI make contact Operating mode is rated operation,
regardless of the mode set at the mode selector switch

Functions WE Configuration

F05 – Potentiometer input 0 F05 - 1

F06 – Resistance range of potentiometer 0 F06 - 0 (Type 5257-7 Room Panel)

5.4 Frost protection

If the controller is in the operating mode OFF/Frost protection (see section 5.3), frost protec-
tion measures are initiated if the following applies:
� Outdoor temperature < 3 °C (outdoor temperature compensated control) or flow

temperature < 15 °C (fixed set point control with room temperature influence)
The circulation pump is switched off and the flow temperature is kept at 20 °C.

5.5 Return flow temperature limitation

The temperature difference between the flow and return flow in a network indicates how well
the energy is used: the greater the difference, the higher the efficiency.

EB 5757-7 EN 19

Functions



A return flow sensor is sufficient to evaluate the temperature difference when the network
flow temperatures are predetermined. The flow temperature set point is reduced when the
Maximum return flow temperature measured at the return flow sensor exceeds the limit tem-
perature:
The reduction amount is calculated from the deviation of the return flow temperature multi-
plied by the factor Kp Return flow temperature limitation. The rate at which the return flow
temperature is reduced by the calculated amount is determined by Tn Return flow tempera-
ture limitation.

The yellow LED blinks slowly if the flow temperature is reduced due to the Return flow tem-
perature limitation function

The return flow is not limited if the parameter setting Tn Return flow temperature limitation =
0 even if a return flow sensor is connected.

Function WE Configuration

F11 – Return flow temperature sensor 1 F11 - 1

Parameter WE Range of values

P13 – Maximum return flow temperature 50 °C 10 to 90 °C

P14 – Kp Return flow temperature limitation 1.0 0.1 to 50.0

P15 – Tn Return flow temperature limitation 400 s 0 to 999 s

5.6 Pump forced operation

A deactivated circulation pump is forced-operated every 24 hours for one minute. This func-
tion is disenabled by selecting F10 - 0 or F09 - 1.

Functions WE Configuration

F09 – Binary output function 0 F09 - 0

F10 – Anti-block protection of pump 1 F10 - 1

5.7 External request for heat demand

The controller with electric actuator can issue a heat demand to a higher-level controller
over the binary output BO in rated or reduced operation. In this case, a coupling relay
(contactor relay with floating contact) must be used to adapt the electrical connection.
This function is only possible when the binary output is not configured as a pump output.

Function WE Configuration

F09 – Binary output function 0 F09 - 1
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5.8 Control principle

The controller with electric actuator functions with a PI algorithm (three-point stepping con-
trol). The valve reacts to pulses which the digital controller issues when a system deviation
occurs. In particular, the length of the first pulse depends on the size of the system deviation
and the selected gain Kp flow temperature control (the pulse length increases as  the Kp
rises). Pulse lengths and intervals change until the system deviation is eliminated. The interval
between individual pulses is influenced considerably by the reset time Tn flow temperature
control (the interval time increases as the Tn rises).
The valve transit time Ty actuator transit time at rated travel reflects the time that the valve
needs to move through its travel range from 0 to 100 %.

Note!
Do not change the default setting WE of P11 (Ty = 25 s) for this device.

Parameters WE Range of values

P09 – Kp flow temperature control 2.0 0.1 to 50.0

P10 – Tn flow temperature control 120 s 0 to 999 s

P11 – Ty actuator transit time at rated travel 25 s 10 to 240 s

5.9 Direction of action

Specify the direction of action depending on the valve used.

Function WE Configuration

F03 – Direction of stem action 0 F03 - 0: SAMSON globe valve
F03 - 1: SAMSON three-way valve

Globe valve (F03 - 0)
� Actual value < Set point: Actuator stem retracts (globe valve opens)
� Actual value > Set point: Actuator stem extends (globe valve closes)
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Three-way mixing valve (F03 - 1)

� Actual value < Set point: Actuator stem extends (three-way mixing valve opens port
A -> AB and closes port B -> AB)

� Actual value > Set point: Actuator stem retracts (three-way mixing valve closes port
A -> AB and opens port B -> AB)
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6 Configuration and operation using TROVIS-VIEW interface

6.1 General

The TROVIS-VIEW software allows various smart SAMSON devices to be configured over a
common operator interface. It consists of the operator interface, communication server, and
the device-specific module. The software has a Windows Explorer look and feel.
The entire configuration of the controller with electric actuator can be performed over the
TROVIS-VIEW Configuration and Operator Interface.
The TROVIS-VIEW software containing online help and the database module for
Type 5757-7 Controller with Electric Actuator is delivered on a CD-ROM (order number
6661-1066).
Software updates are available in Internet (http://www.samson.de) in Products > Support
and downloads.

Note!
The following instructions include a description on the key functions of the TROVIS-VIEW
software in conjunction with controllers with electric actuators. Refer to the online help in the
? menu for a detailed description.

6.1.1 System requirements

Hardware requirements

� PC with Pentium II processor or equivalent (300 MHz or higher), 500 MHz recommended
� Serial interface or USB/RS-232 adapter
� Min. 64 MB RAM, 96 MB RAM recommended
� Min. 150 MB free hard disk space plus approx. 10 to 15 MB additional hard disk space

per SAMSON module
� SVGA graphic card (min. 800 x 600)
� CD-ROM drive

Software

� Operating system: Windows 98, ME, NT 4.xxSP6, 2000 SP2, XP
� Microsoft.NET Framework Version 1.1 (included on the installation CD-ROM)
� Internet browser: MS Internet Explorer, version 6.0 and higher
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6.2 Installing TROVIS-VIEW software

1. Insert the installation CD-ROM to start the installation program.
Once inserted, the CD-ROM usually starts the installation program automatically, de-
pending on the configuration of the operating system. If the program does not start auto-
matically, double-click setup.exe in the root directory of the CD-ROM in order to install
TROVIS-VIEW.

2. Follow the on-screen prompts and instructions of the installation program.

The TROVIS-VIEW Operator Interface can be used for different SAMSON devices. Note that
the installation program also offers you the option of installing a demo module. To use the
software without restrictions, the software needs to be activated by entering a CD key as fol-
lows:

3. After installation, a dialog box will appear, prompting you to enter the CD key, which
you will find on the cover of the original CD-ROM.
Once you have entered the correct CD key and initiated the activation process, a request
code will be automatically generated which contains computer identification details.

4. The Activation dialog box will come up displaying the generated request code and an
Internet link to SAMSON’s activation server. Enter the request code and a unique activa-
tion code will then be generated and displayed.
(http://support.samson-ag.com: 8082/activate_eng.html)

5. Enter this activation code in TROVIS-VIEW’s Activation dialog box.
The software is now ready for use without any restrictions in the purchased scope.

Note!
Refer to the readme.txt file in the root directory of the CD-ROM for further information on in-
stallation, software updates and current system requirements.
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6.3 Starting TROVIS-VIEW and performing settings

You can perform the settings in TROVIS-VIEW either when the actuator is connected (online)
to the PC or without direct connection (offline) (refer to section 7).

Note!
When the device is not connected, the default settings appear on the operator interface or,
alternatively, a stored TROVIS-VIEW file (*.tro) can be loaded and overwritten by selecting
Open in File menu.

1. Start TROVIS-VIEW. The operator interface appears with menubar and toolbar as well as
various folders.

2. In Options menu, select Languages to
change the interface language.

Note!
Languages in gray are not available.

3. Select Customer data in Edit menu to en-
ter data relevant to the plant, e.g. project
name, plant location, operator.

4. Select Load Factory Defaults in Edit menu
(see sections 8.1 and 8.2) if you want to
load default settings onto the operator
interface.
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Properties of data points are indicated by icons on clicking on a folder:

Icon Meaning

Data cannot be changed

Data can be changed

Data point can be executed

Data point is user-defined

Mark to indicate error

Value has exceeded maximum limit

Value has fallen below minimum limit

Connection to the device is interrupted or there is a write protection error

Source of data:

Value has been modified manually

Value has been uploaded from the controller with electric actuator.
In online mode, X in the icon indicates a value has been updated.

Value originates from a stored file

Value has been adopted from memory pen

Value has been changed by the software
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6.3.1 Activating/deactivating functions

1. Click on Configuration folder to view the function block settings.

2. Double-click the function block status (0 or I) to change the status of the function.

Right-click on a row to open pop-up win-
dow to modify configuration settings:

Modify To change the status of the function block.

Read Uploads status of the function block from device.

Write Downloads status of the function block to device.

Default: ... Resets function block to default setting
(setting in gray to indicate that the status of the
function block is the same as the default setting)
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6.3.2 Setting parameters

1. Click on Parameter folder to view the parameter settings.
Note! The parameters listed in the screenshot below are default settings.

2. Double-click on the required parameter
to open pop-up window to modify pa-
rameter settings.
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Right-click on the required parameter to
open pop-up window to modify parame-
ter settings:

Modify Opens pop-up window to
modify parameter set-
tings.

Read Uploads parameter value from device.
Write Downloads parameter value to device.
Default: ... Resets parameter to default setting (setting in gray to indicate that the

parameter value is the same as the default setting)
Min ... Set parameter to the displayed minimum value.
Max ... Set parameter to the displayed maximum value.

6.3.3 Reading operational information

Note!
Operational information can only be read when TROVIS-VIEW is directly connected to the
controller with electric actuator (i.e. in online mode, refer to section 7).

� Select Sensors folder to display actual data measured by the connected sensors as well as
from the binary input and output.
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� Select the Information subfolder in the Diagnostics folder to display information concern-
ing the actuator.

� Select the Error subfolder in the Diagnostics folder to display current error messages.
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7 Data transmission

The TROVIS-VIEW software installed on your PC allows you to configure the controller with
electric actuator either in offline mode (device not connected to a PC) or in online mode (de-
vice connected to a PC). To activate online mode, click on the device toolbar. The commu-
nication port must be set (see section 7.1)

Online mode (direct data transmission)
The actuator and TROVIS-VIEW are con-
nected constantly in online operation. Cur-
rent configuration and operating data are
uploaded from the actuator cyclically and
displayed in TROVIS-VIEW. The settings
configured in TROVIS-VIEW can be directly
transferred to the controller with electric ac-
tuator.
To enable communication with the PC, con-
nect the serial interface (COM port) to the
serial interface (RJ-12 jack) of the controller
with electric actuator using a SAMSON con-
necting cable.
In case the PC does not have a COM port, a
USB/RS-232 adapter can be used when
Windows 98, ME, 2000, or XP operating
systems are installed.

Offline mode (indirect data transmission)
There is no constant data communication
between the PC and actuator. Communica-
tion must first be established to upload from
the actuator or download data to the actua-
tor.
Data can be transferred to the serial
interface over the SAMSON connecting ca-
ble or over a memory pen together with a
modular adapter.
A memory pen allows you to simply copy
and download configuration data onto
other devices.
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Note!
You can only transfer data to the controller with electric actuator after the electrical connec-
tion has been made as described in section 3.

7.1 Data transmission between TROVIS-VIEW and the actuator
(connecting cable)

1. Connect the serial port of the PC using
the SAMSON connecting cable to the se-
rial interface connection of the actuator.

2. Select Communications in Options menu
to open the server settings window. Click
Server settings button.

3. Check Local connection and Auto-
matically local connect boxes and click
on OK button to confirm server settings.

The Communication window reappears.

4. Click Port settings button.

5. The settings window opens and
State: not yet searched appears in the
Automatic detection field.
Click on Start button.
TROVIS-VIEW has found the actuator
when State: Device found on ....
appears, click on OK button twice to
confirm settings.
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7.1.1 Offline operation (indirect data transmission)

In offline mode, there is no constant data communication between the PC and actuator.
Communication must first be established to upload from the actuator and download data to
the actuator.

Downloading data to the actuator:
Select Download to the device in Device menu to transfer data to the actuator. The actuator
starts to control after data are downloaded from TROVIS-VIEW.

Uploading data from the actuator:
Select Upload from device in Device menu to transfer all the data from the actuator.
Uploaded data are indicated in TROVIS-VIEW by the icon.

Note!
Data transmission can also be performed by clicking the icons in the device toolbar:
click to download data from TROVIS-VIEW to the actuator and, click to upload data
from the actuator and to display them in TROVIS-VIEW.

7.1.2 Online operation (direct data transmission)

The actuator and TROVIS-VIEW are constantly connected in online operation. Current con-
figuration and operating data are uploaded from the actuator cyclically and displayed in
TROVIS-VIEW. Likewise, any settings performed in TROVIS-VIEW are directly transferred to
the actuator.
In the event of a sensor breakage, the interruption in sensor connection is shown without de-
lay in the Sensors folder.

Activate online operation:
Select Online in Device menu to activate online mode.
In online mode, in the device toolbar is animated.

Deactivate online operation:
Select Online in Device menu while the online mode is activated.
The online mode is cancelled.

Note!
Alternatively, click in the device toolbar to activate and deactivate online operation.
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7.2 SAMSON memory pen

The SAMSON memory pen serves as a data carrier and is able to load and store data in its
non-volatile memory.

The memory pen can be loaded with data configured in TROVIS-VIEW and the settings
transferred to one or several controllers with electric actuators. In the same way, the memory
pen can be used to upload data from the actuator allowing you to simply copy the
configuration data from one actuator to another actuator of the same type.

Note!
On inserting a memory pen that is empty or that contains data from another type of device
into the serial interface port of the actuator, the data from the actuator are uploaded to the
memory pen regardless of the status of the memory pen and any other data on the memory
pen will be overwritten.

7.2.1 Data transfer between TROVIS-VIEW and memory pen

1. Plug memory pen (3) together with modular adapter (2) into the serial interface (COM
port) of the PC (Fig. 13).
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2. Select Interface in the Memory Pen menu.

3. Click the Start button in Automatic detection field of the dialog box. The computer auto-
matically searches for the interface assigned to the memory pen.
Message: “Memory pen found at COM …“
Confirm interface setting by clicking OK button.

Downloading data from TROVIS-VIEW to the memory pen

4. Select Download to Memory pen in Memory pen menu

5. Click OK button to start data transmission.

Uploading data from memory pen to TROVIS-VIEW

4. Select Upload from Memory pen in Memory pen menu to start data transmission.

7.2.2 Data transmission between actuator and memory pen

� Perform steps 1 to 3 described in section 7.2.1.
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Uploading data from the actuator to
memory pen

4. Select Modify memory pen status in
Memory pen menu.
Check Automatically write to memory
pen in the dialog box.
Click OK button to confirm.

5. Remove memory pen from PC and plug it
into the serial interface of the actuator
(Fig. 14).
Actuator data are uploaded onto the
memory pen.
The yellow LED under the serial interface
blinks twice several times to indicate that
data transmission is in progress.
Data transmission is completed when the
LED is illuminated continuously.
Remove the memory pen from the actuator.

Downloading data from the memory pen
to the actuator

4. Select Modify memory pen status in
Memory pen menu.
Check Automatically read from memory
pen in the dialog box.
Click OK button to confirm.

5. Remove memory pen from PC and plug it
into the serial interface of the actuator
(Fig. 14).
Data are downloaded from the memory
pen into the actuator.
The yellow LED under the serial interface
blinks several times to indicate that data
transmission is in progress.
Data transmission is completed when the
LED is illuminated continuously.
Remove the memory pen from the actuator.
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7.2.3 Copy function

The memory pen can be used to copy setting data to other Type 5757-7 Actuators as soon
as the data from the actuator have been transferred to the memory pen (indicated by the yel-
low LED blinking twice several times). Automatically write to memory pen is reset after the
first data transmission from the actuator.

7.2.4 Manual operation

Caution!
Activate the handwheel (red knob) only when the actuator is de-energized.

The controller with electric actuator can be set to manual operation using the memory pen
while the control operation is running:

� Perform steps 1 to 3 described in section 7.2.1.

4. Select Modify manual operation status in
Memory pen menu.

5. Check either Stem extends or Stem re-
tracts in the dialog box.

6. Click OK button to confirm.

7. Remove memory pen from PC and plug it
into the serial interface of the actuator
(Fig. 14).
The valve stem extends or retracts ac-
cording to the option selected previously.

8. After removing the memory pen from the
actuator, the actuator returns to its nor-
mal control state.

Reset manual operation status in memory pen

1. Plug memory pen (3) together with modular adapter (2) into the serial interface (COM
port) of the PC (Fig. 13).

2. Check No manual operation in the dialog box.

3. Click OK button to confirm.
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8 Appendix

8.1 Function block list

The function blocks F01 to F11 have the following listed function.

F = Function block WE = Default setting 0 = OFF, 1 = ON

F Function WE Comment

01 Control mode 1 0 – Fixed set point control → Section 5.2
1 – Control with reference variable → Section 5.1

02 Selecting the reference
variable

0 0 – Outdoor sensor → Section 5.1
1 – Room sensor → Section 5.2.1

03 Direction of stem action 0 0 – SAMSON globe valve → Section 5.9
1 – SAMSON three-way valve → Section 5.9

04 Delayed outdoor
temperature

0 0 – Without delay
1 – With delay → Section 5.1.3

05 Potentiometer input 0 0 – Inactive, binary input active → Section 5.3.1
1 – Active → Section 5.1.1, 5.3.2, 5.3.3

06 Resistance range of
potentiometer

0 0 – Type 5257-7 Room Panel (1000 … 1100 Ohm)
→ Section 5.3.2, 5.3.3

1 – Type 5257-2 w. remote adjuster (1000 … 2000 Ohm)
→ Section 5.1.1

07 Function of potentiometer 0 0 – Heating characteristic level shift → Section 5.1.1
1 – Gradient shift → Section 5.1.1

08 Function of binary input 0 0 – BI short-circuited: OFF w. frost protection → Section 5.3.1
1 – BI short-circuited: Reduced operation → Section 5.3.1

09 Function of binary output 0 0 – BO as circulation pump control → Section 5.6
1 – BO as heat demand → Section 5.7

10 Anti-block protection of
pumps

1 0 – No anti-block protection
1 – When pumps are deactivated: switched on every 24 h
for 1 min → Section 5.6

11 Return flow temperature
sensor

1 0 – OFF
1 – ON → Section 5.5
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8.2 Parameter list

The parameters have the setting ranges as listed below.

P = Parameter WE = Default setting

P Parameter WE Setting range

01 Flow temperature set point 70 °C 0 to 150 °C

02 Flow temperature set-back in reduced operation 15 K 0 to 50 K

03 Minimum flow temperature 20 °C 0 to 150 °C

04 Maximum flow temperature 120 °C 0 to 150 °C

05 Heating characteristic gradient 1.6 0.2 to 3.2

06 Heating characteristic level 0 K –30 to 30 K

07 Gradient shift range via potentiometer 1.0 0.0 to 1.5

08 Level shift range via potentiometer 15 K 0 to 30 K

09 Kp flow temperature control 2.0 0.1to 50.0

10 Tn flow temperature control 120 s 0 to 999 s

11 Ty actuator transit time at rated travel 25 s 10 to 240 s

12 Tr flash adaptation 10 min 0 to 100 min

13 Max. return flow temperature 50 °C 10 to 90 °C

14 Kp return flow temperature limitation 1.0 0.1to 50.0

15 Tn return flow temperature limitation 400 s 0 to 999 s

16 Delayed time for outdoor temperature 3.0 °C/h 1.0 to 6.0 °C/h

17 Outdoor temperature limit at rated operation 22 °C 0 to 50 °C

18 Outdoor temperature limit at reduced operation 15 °C 0 to 50 °C

19 Room temperature limit at rated operation 20 °C 10 to 40 °C

20 Room temperature limit at reduced operation 15 °C 10 to 40 °C

21 Max. room temperature boost 1 K 1 to 6 K

22 Pump lag time 5 min 1 to 999 min

EB 5757-7 EN 39

Appendix



8.3 Customer settings

Function blocks Parameters

F WE
Setting

performed P WE
Setting

performed Setting range

01 1 01 70 °C 0 to 150 °C

02 0 02 15 K 0 to 50 K

03 0 03 20 °C 0 to 150 °C

04 0 04 120 °C 0 to 150 °C

05 0 05 1.6 0.2 to 3.2

06 0 06 0 K –30 to 30 K

07 0 07 1.0 0.0 to 1.5

08 0 08 15 K 0 to 30 K

09 0 09 2.0 0.1to 50.0

10 1 10 120 s 0 to 999 s

11 1 11 25 s 10 to 240 s

12 10 min 0 to 100 min

13 50 °C 10 to 90 °C

14 1.0 0.1to 50.0

15 400 s 0 to 999 s

16 3.0 °C/h 1.0 to 6.0 °C/h

17 22 °C 0 to 50 °C

18 15 °C 0 to 50 °C

19 20 °C 10 to 40 °C

20 15 °C 10 to 40 °C

21 1 K 1 to 6 K

22 5 min 1 to 999 min
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